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1 Demo

Thank you very much for your interest in our program GOOSE Inspector. We ask for your kind understanding that
the demo version is subject to the following restrictions:

After 3 minutes of online operation, the program automatically goes offline and terminates the recording.
To start a new recording, a restart of the program is required.
Neither data nor settings can be saved or exported.
When reading in a configuration file (SCD or ICD), approximately 40% of the IEDs and 40% of the remaining
GOOSE are suppressed by means of a random function. This means that only a limited number of IEDs and
GOOSE will be available for test purposes. The representation in the SCD Viewer and in the Siemens

Application Monitor (SAM) is restricted accordingly. About 65% of all GOOSE messages are processed as if
they were not included in the configuration file. In order to be able to load another configuration file, a restart of
the program is required.

Initial Test with Demo Data

If it is not possible for you to record data, you can perform an initial test using demo data. The demo.scd and
demo.lg6 files are available in the program directory of GOOSE Inspector. Since the demo.scd file is subject to
the restrictions described above, it might be necessary to load the file several times in order to be able to view an

IED and GOOSE messages in the SCD Viewer or the Siemens Application Monitor (SAM). As a next step, you
can now load the demo.lg6 file.

2 Installation

2.1 Installation Overview

The program is executable under Windows XP Professional SP2/SP3 (32 Bit), Windows Vista Business (32 Bit),
Windows 7 Ultimate (32/64 Bit) and Windows 10 Pro (32/64 Bit).

Administrator rights are required for the installation of the program. The operation of the program, however, is also
possible without administrator rights.

Installation

Uninstall former versions first. Then start the setup file form the folder "Demos". The file name is
SetupGOOSEInspector_Demovx.exe (x is the version number). 
Example: SetupGOOSEInspector_Demov1300.exe = the installation routine for GOOSE Inspector Version
1.3.0.0.

Follow the instructions provided on screen. GOOSE Inspector can be used immediately without a restart of the
operating system.

A dongle is required as proof of the license and must not be removed during program execution.

Each time a new user starts the program for the first time with his own user ID, the program will create a user-
specific data directory "C:\Documents and Settings\<User>\ Application Data\GOOSE Inspector Data\". This
directory contains the user-specific Log and program configuration files (*.cfg). The directory can be modified by
the corresponding user via the following menu in the main program: “Settings | Net interface/ Log... | Data
Directory”.

Recommended setting: In some cases the font of the Main Window, Detailed View and GOOSE Monitor is slightly
fuzzy. To change this, please uncheck the method "to smooth edges of screen fonts" of the operating system.
Within Windows XP this option can be found at: Control Panel/Display Properties/Appearance/Effects...
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Uninstallation

Exit the program and use the "Software" utility routine provided by Windows (Start | Control Panel | Software) to
uninstall the program.

2.2 System Requirements

Component Minimum Recommended

Operating system Windows XP, 32 Bit, SP2/3 Windows 10, 32/64 Bit
Processor Single CPU 1,3 GHz Dual Core CPU 1,6 GHz
RAM 500MB 2 GB
Graphic card SVGA WXGA
Network units Network interface (Ethernet LAN, TCP/IP)Network interface (Ethernet LAN, TCP/

IP)
Interfaces One USB interface for the dongle One USB interface for the dongle
Table 1: System requirements

2.3 Storage Structure of the CD

Folder Sub-Folder Contents

Demos Setup file and version history
Doku

English English documentation
German German documentation

Table 2: Storage structure of the CD

3 Overview

3.1 Description of Functions

Basic Functionality

The GOOSE Inspector  monitor program allows you to listen to IEC 61850 substation automation protocol
packets via the network.

It is connected to the network via the network interface of your PC.

The IEC 61850 packets are decoded (except GSE and SV), checked, displayed, filtered if required, saved in the
Log.lg6 circular buffer file and printed if required. For long-term records, an error log file (Log.er6) and an event log
file (Log.el6) can be additionally created.

Figure 1: Main Window w ith packet list and Detailed View

Furthermore, the program monitors the GOOSE transmission via the network and displays the current status in a
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comprehensive overview table in the GOOSE Monitor. Some specific information, such as the current sum status
of all GOOSE messages, is made available to higher-level monitoring systems via SNMP (Simple Network
Management Protocol). Via an integrated SNTP request (Simple Network Time Protocol), the program can
automatically synchronize the PC clock.

The import of a configuration file (SCD/ICD) extends the volume of data displayed in the Detailed View
accordingly. In addition, various views of the data structure of the IEDs, GOOSE messages, inputs, reports and
ldName are available when loading a configuration file. The program supports SCD files of edition 1.0 and 2.0.

Offline Analysis of data, monitored during a link connection, provide additional information about
dynamically created DataSets and Information Reports in many cases.

Operators of Siemens systems will be able to benefit from a particularly well arranged representation in the 
Siemens Application Monitor (hereinafter referred to as the “SAM”). This view shows the current status of
applications and GOOSE via icons highlighted in traffic-light colors.

Furthermore, the SAM allows the export of a signal list which provides a clear overview of the source and target of
a connection. The user has the option of creating a signal list for the systematic checking and documentation of
signals step by step.

The program supports the import of FAST files. This allows a detailed analysis of the GOOSE communication in
special feeder systems from Siemens.

Figure 2: Siemens Application Monitor (SAM)

User-Specific Data Directory

Each time a new user starts the program for the first time with his own user ID, the program will create a user-
specific data directory "C:\Documents and Settings\<User>\ Application Data\GOOSE Inspector Data\". This
directory contains the user-specific Log and program configuration files (*.cfg). The directory can be modified by
the corresponding user via the following menu in the main program: “Settings | Net interface/ Log... | Data
Directory”.

When exiting the program, the parameter settings, the representation settings and the Log.lg6 circular buffer file
are saved automatically. The files Log.er6 (error log file) and Log.el6 (event log file) are saved automatically too, if
activated.

Properties of the Log.lg6, Log.er6 and Log.el6 circular buffer files

The program checks the packets received for formal correctness. Erroneous or unknown packets are marked
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accordingly. With inaktive input filter, all received packets are marked with a time stamp and saved in the circular
buffer file Log.lg6.

The maximum size of the Log file and the data directory can be specified via parameter settings (see Parameters
for network and Log file ). The program always uses the “Log.lg6” file for recording. 

You can also display, filter and scroll up and down the Log file during reception. The use of this option is
recommended mainly for the real-time analysis of GOOSE errors during a recording phase.

Observe the recommendations concerning the maximum size of the circular buffer file and do not run or operate
any other program on your PC during a recording session. 

The Log.er6 (error log file) and Log.el6 (event log file) circular buffer files are stored in the same directory as the
Log.lg6 file. They are created during the recording process and can only be used upon completion of a record.
Since only specific information is recorded, the circular buffers are sufficiently dimensioned for long recording
periods and thus allow the long-term recording of specific information. 

For more detailed information, refer to Chapter Circular buffer file .
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Colors and Filters

You can define the display colors for the server and the client using the related menu options in the Font size,
Message color menu. The input filter can be used to reduce the amount of data, that should be recorded. For the
output of the packets, you can apply the following filtering criteria:  

Time
Packet status, Packet source and Packet type
IP address (MMS)
Any text (e.g. logic device, logic node or reference)
GOOSE Control Block Reference
Packet number and packet length. 

By entering the designations of the logic device and logic node in plain text and selecting MMS at the same time,
you can e.g. specifically filter those reports which include relevant switching states and measured values. Within
the SCD Viewer these parameters can be set easily by means of a right click on a selected report.

The GOOSE Control Block Reference can also be set by means of a simple right click in the GOOSE Monitor,
the SAM or the SCD Viewer. This facilitates the GOOSE analysis.

3.2 Getting Started

Dongle

Plug the dongle into the USB interface and start the program.

Language

Via the “Settings | Language” menu, you can select the English or German user interface. The default setting
depends on the current system language and is either German or English.

Network Connection

Although the program does not send any data packets, you should ensure that your computer cannot cause
address conflicts in the network. For safety reasons, contact the administrator with regard to the correct
procedure, e.g. automatic reference of the IP address or use of a specific IP enabled for you.

Figure 3: Schematic representation of the netw ork structure
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If you plug the network connector of your PC into a normal port of a switch, you will mainly receive GOOSE
messages. MMS services or general data traffic will not be forwarded to your PC via a normal switch. This can
be useful if you want to focus on the reception and analysis of GOOSE messages.

In order to listen to all packets, plug the network connector of your PC into the service port (monitor or mirror
port) of a switch whose parameters have been specified accordingly. Make sure that the packets which you
want to listen to (i.e. TCP/IP and multi-cast GOOSE packets) are actually transmitted via the port.  You can
also interconnect a switch with a mirror port (or HUB or TAP) into a device connection. A conventional
unmanaged switch is not suitable because it only forwards the MMS packets to the target addresses. 

Before starting the recording, select the desired network card in the menu: "Settings | Network/Log... ". Next,
click on OK to save the parameter settings.

Loading the Configuration File and Starting the Recording

If you have a configuration file (SCD/ICD) for your system, you should already load it before the first recording
session. You can also perform a recording without loading a configuration file and have it analyzed afterwards
based on the configuration file.

Load a configuration file via the following menu: "File | Open...". Select and confirm the subnet you are
connected to (only in case of SCD edition 2.0 with more than one subnet). Select "Reset error counter for a new
capture". Operators of Siemens systems can now open the Siemens Application Monitor (SAM) via the View
menu.

Next, select the “Online View” view (View menu).
Select “All packets” (View menu).
Afterwards, go online (Mode menu). The following selection window opens:

 Figure 4: Selection options available at the start of a recording

Select "Reset counters and append capture to Log.lg6".

From now on, all received packets will be saved in the Log.lg6 circular buffer and shown without filtering.

Change the output format of the Detailed View using the View menu or the “3 to 6” hotkeys. The current output
format is shown in the title bar of the Main Window.

Additional display options before and after the recording are described in the Chapter “Program Windows and
Operation”.

Possible Error Messages of the Dongle

If “f.n.n.n dongle missing/incorrect” is displayed after selecting the online mode, perform the following checks:
- Were you logged on as an administrator upon the installation of the program?
- Is the dongle plugged into the USB interface?

The f.n.n.n error code has the following meaning:
2, 1011 oder 1034.n.n.n Dongle not found
1004, 1005 oder 1006.n.n.n Device driver not installed
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4 Program Windows and Operation

4.1 Main Window and Detailed View

The usual Windows conventions apply for maximizing, minimizing and closing the program windows.

The packets are shown in two windows, i.e. the Main Window and the Detailed View. In addition, the GOOSE
Monitor and the SAM can be used specifically for GOOSE monitoring. The SCD Viewer with its different views is
available for the detailed and structured representation of the configuration file.

Main Window

The Main Window includes the menu bar and shows each packet in a separate line. The following two views are
available:

The "File View" for scrolling already saved packets
The “Online View” for observing the currently arriving packets in real time

The "File View"

The “File View” allows the user to scroll the lg6 file, which has just opened, in order to perform specific analyses
of individual packets. This is also possible during a recording session, i.e. the user can scroll the data recorded in
the Log.lg6 circular buffer file. The data displayed in this view is influenced by the filter settings.  

Figure 5: The “File View ” in the Main Window

Information about the current view is shown in the separate line below the menus. The packet data, the number of
the uppermost packet and the total number of packets are shown in the line below.
The following lines include the packet number, a time stamp, the time difference “d” to the packet displayed last,
the packet source address, the receiver address (i.e. the MAC or IP address with port) and the packet type. 
If a GOOSE contains errors, a short code follows for each detected error as described in Table 13 in the Chapter
"GOOSE Monitor".

The bold packet is shown in the Detailed View.
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In order to scroll in the current file, the scroll bar, the cursor keys, the mouse wheel and the hotkeys listed below
can be used while the Main Window is active.

Operation Effect

Mouse wheel or cursor keys 1 packet

Page Up/Down keys 5 packets

Page Up/Down keys + SHIFT 50 packets

Page Up/Down keys + Ctrl 500 packets

Page Up/Down keys + Ctrl +
SHIFT

5000 packets

End Packet received last/most recent packet

Home Packet received first/oldest packet
Table 3: Scrolling in the Main Window

A millisecond counter is used for the time stamp of the packets. Upon each change from Offline to Online mode,
and then every 10 minutes afterwards, this counter is synchronized with the PC clock time.

If the packets currently shown in the display are overwritten by the packets received online, the packet received
last will be displayed upon the next scrolling.

The “Online View”

The packets are shown one below the other in a consecutive list in the “Online View”. The packet received most
recently is shown in the bottom line of the list. The data displayed in this view is influenced by the filter settings.

Figure 6: The “Online View ” in the Main Window

Information about the current view is shown in a separate line below the menus. 
The following lines have the same structure as in the “File View”.

The packet shown at the bottom of the list will be displayed at intervals of approx. one second in the Detailed
View. In case of events happening slowly, e.g. due to an appropriate filter selection for GOOSE or an
InformationReport, the values of the attributes can be traced in real time. 

In order to carefully view the packets received, press the F9 hotkey to open the “File View”. The display changes
and the program continues to receive packets in the background.



12 GOOSE Inspector

© 2017 Berthold Boeser Engineering Consultants

Detailed View

The “current” packet is shown in the selected output format in the Detailed View. Select the output format via the
View menu or via hotkeys. The View menu can also be called up by clicking with the right mouse button in the
Main Window!

Using the ’TAB’ key, you can switch the focus between the Main Window and the Detailed View.

The "Logic" and "Details" views can be expanded by activating "SCD" in order to retrieve information from a
loaded configuration file.

      

Figure 7: "Logic" Detailed View w ithout SCD                   Figure 8: "Details” Detailed View w ithout SCD

      

Figure 9: "Logic" Detailed View w ith SCD                        Figure 10: "Details" Detailed View w ith SCD

When the Detailed View is active, the user can scroll the packets of the current file from this view. It is not
necessary to change to the Main Window. 
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Operation Effect
Ctrl + cursor keys 1 packet
Ctrl + Page Up/Down keys 5 packets
Ctrl + End Packet received last/most recent packet
Ctrl + Home Packet received first/oldest packet
Table 4: Scrolling in the Main Window w hile Detailed View is active

If the output of a packet is too large for the Detailed View, you can use the scroll bar, the mouse wheel or the
cursor keys in order to scroll up and down the Detailed View.

4.2 Hotkey operation

Although the graphic user interfaces of  GOOSE Inspector provide functions which can be operated with the
mouse, many functions can be executed faster and more conveniently using hotkeys. For this reason, this
chapter provides an overview of the most important hotkeys:

'F8' – Select the Online/Offline mode
Press ’F8’ to change between Online and Offline mode.

'F9’ – Select between 'File View' and 'Online View'
Press ’F9’ to change between 'File View’ and 'Online View’.

'F11' – Activate/deactivate the output filter
Press ’F11’ to activate or deactivate the output filter.

'F12' – Call up the output filter
Press ’F12’ to open the dialog for specifying the parameter settings of the output filter.

'1' – Show all packets
Press ‘1’ to show all packet types.

'2' – Show only 61850 packets
Press ‘2’ to show only 61850 (MMS and GOOSE) packets. The output filter provides an additional filtering
option.

'3' – Open the “Logic” Detailed View
The output in the Detailed View only displays the most important data.

'4' – Open the “Details” Detailed View
The output in the Detailed View shows more detailed information.

'6' – Byte-serial HEX display in the Detailed View
The output in the Detailed View is ‘hexadecimal’.

‘TAB’ key to switch between the Main Window and the Detailed View
Use the TAB key to switch the (input) focus between the Main Window and the Detailed View.

'Cursor Up/Down’ to scroll packet by packet (in the Main Window)
Use the cursor keys to scroll packet by packet (with the focus in the Main Window) or to scroll line by line (with
the focus in the Detailed View).

'Page Up/Down’ to scroll 5 packets up or down (in the Main Window)
Use the ‘Page Up/Down’ keys to scroll 5 packets up or down (with the focus in the Main Window) or to scroll by
ten lines (with the focus in the Detailed View).

'Ctrl+Page Up/Down’ to scroll 50 packets up or down (only in the Main Window)
Hold down the ‘Ctrl’ key and press 'Page Up/Down’ to scroll 50 packets up or down.
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'SHIFT+Page Up/Down’ to scroll 500 packets up or down (only in the Main Window)
Hold down the ‘SHIFT’ key and press 'Page Up/Down’ to scroll 500 packets up or down.

'Ctrl+SHIFT+Page Up/Down’ to scroll 5,000 packets up or down (only in the Main Window)
Hold down the ‘Ctrl’ and 'SHIFT’ keys and press 'Page Up/Down’ to scroll 5,000 packets up or down.

'Ctrl+Cursor Up/Down’ to scroll packet by packet (only in the Detailed View)
Hold down the ‘Ctrl’ key and press 'Cursor Up/Down’ to scroll packet by packet.

'Ctrl+Page Up/Down’ to scroll 5 packets up or down (only in the Detailed View)
Hold down the ‘Ctrl’ key and press 'Page Up/Down’ to scroll 5 packets up or down.

'Ctrl+D' to delete the current Log file
The ’Ctrl+D’ key combination deletes the current Log file and the GOOSE references. 
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4.3 Siemens Application Monitor (SAM)

Operators of Siemens systems will be able to benefit from a particularly well arranged representation in the 
Siemens Application Monitor (hereinafter referred to as the “SAM”). This view shows the current status of
applications and GOOSE via icons highlighted in traffic-light colors. 

The complete tree view, the Description area and the Parameters area in the SAM are only available after loading
an SCD with special features.

Structure of the SAM Window

The SAM window is divided into the following four areas:

The tree view provides a graphical representation of all applications and the GOOSE messages included.
The Description area in the upper center of the screen shows all sources and targets of the node selected
from the tree.
The GOOSE Monitor in the bottom center of the screen shows runtime information concerning all GOOSE of
the node selected from the tree.
The Parameters area in the far right of the screen compares information from the configuration file and
received parameters of the node selected from the tree.

Figure 11: The four areas of the Siemens Application Monitor (SAM) 

Several menu items are available above the SAM.

Reset counter – Resets all counters for errors and warnings; the left-hand side of the icons is displayed in
green.
SAM – Allows the user to hide individual columns of the description area.
Export signal list – Exports an CSV file which includes all sources and targets according to the configuration
file.
GOOSE Monitor – Allows the user to hide individual columns of the GOOSE Monitor.

You can sort according to any column in the Description area and the GOOSE Monitor. Place the mouse pointer
over the title bar and click with the left mouse button. Clicking again reverses the sorting order. The order of
sorting is not displayed.
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Icons and Colors in the Tree View

The following four icons are used in the tree view of the SAM:

Subnet

Application

GOOSE / GOOSE control

undefined GOOSE
Table 5: Icons in the tree view  of the SAM

Subnet, application and GOOSE
The icons are arranged based on the information included in the configuration file. A subnet is the uppermost
level; a GOOSE is the lowest element in the hierarchy.

Siemens applications are created on the basis of private attributes in the SCD. 

The assignment of GOOSE to Siemens applications is also performed via private attributes. 

All GOOSE which do not have these private attributes are collected in "generated" applications. Each "generated"
application only includes GOOSE with the corresponding application ID (AppID, indicated as a decimal number).

Figure 12: Generated application w ith AppID=1224 and Siemens application

Undefined GOOSE
This node displays all GOOSE messages which have been transmitted via the network, but which are not
described in the configuration file.

Colors
Depending on the status of the node or element, the icons are shown in the following colors:

Configuration file

Normal Warning Error

Log file

Normal

Warning

Error

Inaktive
Table 6: Color combinations of the icons in the tree view  of the SAM

The color in the left-hand side of the icon shows runtime warnings and runtime errors represented in more detail in
the GOOSE Monitor or in the Parameters area.
The color in the right-hand side of the icon shows warnings and errors with regard to the loaded configuration file. 

The colors change according to the following rule:

No warning or error / everything OK

At least one warning, but no error pending

At least one error, but warnings may be pending as well

Element is part of a inactive subnet, therefore no runtime data available
Table 7: Signif icance of the colors of the icons in the SAM
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Since the icons in a level always display the worst state of the icons arranged below, the cause of an error
displayed at the uppermost level can be conveniently traced back to a lower level.

Figure 13: The application alw ays show s the w orst property of the GOOSE included

Representation in the Description area

The Description area shows all the sources and corresponding targets of the node selected from the tree.

A data object with a source description is displayed as source for all devices. 

Only for Siprotec devices, a data object with a target description is displayed as target.

For all other devices, the input position (ExtRef) is shown as target. The program complements the ExtRef with
an ordinal number. The "Internal Address" (IntAddr) in the field highlighted in gray is indicated as target
description. 

Figure 14: Target view  w ith Siprotec devices and other devices

Warnings and Errors Concerning the Configuration File – Right-Hand

Side of the Icons

When loading a configuration file, the tree structure is set up and the configuration file is checked. Detailed
information on warnings or errors concerning the configuration file is shown by means of an extended tool tip. To
show the tool tip, place the cursor on the icon of a GOOSE. The extended tool tip is shown only for GOOSE
which appear in yellow or red on the right-hand side!

Figure 15: Example for a w arning concerning the configuration f ile 
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Warnings and Errors Concerning the Log File – Left-Hand Side of the

Icons

Warnings and errors with regard to the Log file are created during a recording session and can have the following
two causes:

The running GOOSE transmission is not free of gaps and inconsistencies.
The parameters transmitted with a GOOSE differ from the values defined in the configuration file.

Warnings and errors concerning the GOOSE transmission are shown in detail in the GOOSE Monitor.
Warnings and errors concerning the parameters are shown in detail in the Parameters area.

The warnings and details shown in the Parameters area and the GOOSE Monitor directly influence the status of a
GOOSE and thus the color shown in the left-hand side of the GOOSE icon.

All icons within an inactive subnet will be displayed with a grey left-hand side.

GOOSE Monitor (in the SAM)

The information shown in the GOOSE Monitor is continuously updated and influences the color in the left-hand

side of the icons.

Figure 16: Example of a GOOSE w ith tw o errors and a GOOSE w ith tw o w arnings… 

Figure 17: … and the corresponding representation in the tree view   

Colum Function

Missing Field filled in red => GOOSE currently missing

Reference Reference of the GOOSE Control Block

MAC Sender MAC address of the sender

TAL Time allowed to live

Total Total number of GOOSE

E Total number of errors

W Total number of warnings

Stat.No. Number of errors caused by the status number

Seq.No. Number of errors caused by the sequence number

D_TAL Number of errors caused by at least a double timeout of the
permissible Time allowed to live (TAL)

S_TAL Number of warnings caused by at least a simple timeout of the
permissible Time allowed to live (TAL)

SGM Number of single missing GOOSE (simple sequence number
violation)

Reboot Number of detected reboots (Stat.No. = Seq.No. = 1)
Table 8: Signif icance of the columns of the GOOSE Monitor in the SAM 

The GOOSE Monitor will be shown greyed if you select a tree view icon from an inactive subnet.

Parameters Area

The parameters in the Parameters area are only captured once per recording phase. Most of the values are
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already determined with the first GOOSE. The errors and warnings shown in the Parameters area influence the 
color in the left-hand side of the icons.

Figure 18: Parameters w indow  for a GOOSE

The parameters displayed in green are checked. They change their color in case of discrepancies between the
configuration file and the Log file. At the same time, the warning or error will be shown as the status in the tree
view. It is possible to deactivate individual check criteria in the "Settings | GOOSE Parameter Checks" menu. 

The MAC address here is the virtual receiver address. The sender address is displayed in the GOOSE Monitor.

The VLAN parameters are only evaluated upon their reception.

The minimum and maximum transmission times are calculated from the time stamps of the first suitable GOOSE
sequences. They will not be checked against the values of the configuration file.

All other parameters displayed in black are not encoded in the GOOSE and are shown only for information
purposes.

The Parameters area will be shown greyed if you select a tree view icon from an inactive subnet.

Setting Filters for Further Analyses in the Detailed View

If runtime warnings or runtime errors are shown for a GOOSE and have to be further investigated, it is helpful to
search the existing record for erroneous packets first and then further examine the correct transmissions which
took place before. In the SAM, a filter can be conveniently set as follows:

In the GOOSE Monitor: by marking the desired GOOSE and clicking with the right mouse button
In the tree view: by marking the desired GOOSE and clicking with the right mouse button

The following view opens in both cases:

Figure 19: Marking a GOOSE and setting a f ilter by clicking w ith the right mouse button 

Filter (all)  => Shows all GOOSE packets of the selected GOOSE ControlBlock reference.
Filter (only erroneous) => Shows only erroneous GOOSE packets of the selected GOOSE ControlBlock

reference.
 
The convenient handling of filters is also supported in the Main Window. For more detailed information, refer to the
Chapter Output filters.



20 GOOSE Inspector

© 2017 Berthold Boeser Engineering Consultants

4.4 SCD Viewer

The SCD Viewer shows the contents of a configuration file in the following tree views:

IED shows the data structure of the individual IEDs.
GOOSE shows the data included in a GOOSE and the inputs fed by this GOOSE.
Input shows all external references to the configuration file and the corresponding GOOSE which includes
this data.
Report shows the data structure of the individual reports.
LDName shows the data structure of all logical devices with functional naming via the attribute ldName.
DynRep shows the data structure of dynamically defined Information Reports after an Offline Analysis (as far
as possible) or an import of an ascd file. 
DynDatSet shows the data structure of dynamically defined DataSets after an Offline Analysis (as far as
possible) or an import of an ascd file. 

In addition to the tree view, the parameters and properties of the selected node are displayed in the information
box on the right-hand side.

Figure 20: Tree view  of the data structure of an IED w ith additional information concerning the number of GOOSE in the IED  

In the IED tree view, the number of GOOSE messages and inputs is shown under IED and LD.

The output shown in the IED tree view can be modified by means of the "IED View" menu item.
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Dynamically defined elements from Offline Analysis can be saved in an ascd file by means of the "Save
dynamic elements" menu item.
Acsd files can be reloaded via the menu: "File | Open...". This replaces a repeated Offline Analysis with the
same data.

Figure 21: GOOSE (GOOSE ControlBlock reference) w ith data and inputs included w hich are using this GOOSE  

Figure 22: Input (external reference) and GOOSE (GOOSE ControlBlock reference) w ith the required data (attribute)

Figure 23: Report w ith the corresponding DataSet and the data included in the DataSet
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Figure 24: Tree view  of the data structure of all logical devices w ith functional naming via the attribute ldName

Icons and Colors in the SCD Viewer

IED

Server

Accesspoint

Logical Device

Logical Node

Data Object

Data Attribute
Basic Data Attribute

Report Control
Trigger Options
Option Fields

Data Set

Functional Constraint Data Attributes (FCDA)

GOOSE Control

Input

GOOSE

Data Attribute Type

Data Object Type

Enumeration Type

Enumeration Value

Logical Node Type
Table 9: Icons and their signif icance in the IED, GOOSE, Input and Report tree view s
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4.5 GOOSE Monitor

The GOOSE Monitor allows the user to check the quality of all GOOSE in the connected subnet in real time and
to represent it in a comprehensive overview table.

The GOOSE Monitor is also available without a configuration file. In this case, however, it can only monitor those
GOOSE messages which have been received at least once during a recording session.

During a recording, all GOOSE received are evaluated with regard to their StatusNumber, SequenceNumber and
Time allowed to live (TAL). In addition, the complete failure of a GOOSE is monitored.

When a configuration file is loaded, the program additionally checks whether all configured GOOSE actually exist
in the network. Furthermore, some parameters of the corresponding GOOSE which was received first are
compared with the configuration file.

Display of the Current Status of a GOOSE

The user can sort according to any column in the GOOSE Monitor. Place the mouse pointer over the title bar and
click with the left mouse button. Clicking again reverses the sorting order. The order of sorting is not displayed.

Figure 25: GOOSE Monitor w ith GOOSE examples for the Warning, OK and Error statuses  

The status of a GOOSE is defined as follows:

No warning or errors  / everything OK

At least one warning, but no error pending

At least one error, but warnings may be pending as well
Table 10: Signif icance of the colors in the Status f ield of the GOOSE Monitor

The Missing column is defined as follows:

GOOSE currently received as expected

GOOSE missing since at least 2 x Time allowed to Live (Missing)
Table 11: Signif icance of the colors in the Missing f ield of the GOOSE Monitor

If a GOOSE is set to ‘Missing’ and received again afterwards, ‘Missing’ is undone. However, all warnings and
errors caused by the failure are still shown.
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Table Structure

Colum Function Available without
configuration file

Status Green = OK, yellow = warning, red = error yes

Missing Field filled in red => GOOSE currently missing Yes, for GOOSE already
captured

Reference Reference of the GOOSE Control Block yes

MAC Sender MAC address of the sender yes

TAL Current Time allowed to live yes

Total Total number of GOOSE yes

F Total number of errors yes

W Total number of warnings yes

Stat.Nr. Number of errors caused by the status number yes

Seq.Nr. Number of errors caused by the sequence number yes

D_TAL Number of errors caused by at least a double timeout of the
permissible Time allowed to live (TAL)

yes

S_TAL Number of warnings caused by at least a simple timeout of
the permissible Time allowed to live (TAL)

yes

SGM Single GOOSE Missing - Number of single missing GOOSE
(simple sequence number violation)

yes

Reboot Number of reboots detected (Stat.No. = Seq.No. = 1) yes

LOG  X = GOOSE included in the file yes

SCD  X = GOOSE included in the configuration file yes

GPS GOOSE parameter status (green, yellow, red) no

GPE Number of GOOSE parameter errors (i.e. the GOOSE
parameters transmitted do not match the configuration file)

no

GPW Number of GOOSE parameter warnings (i.e. the GOOSE
parameters transmitted do not match the configuration file)

no

Table 12: Signif icance of the columns in the GOOSE Monitor without the GOOSE parameter fields

The status of the GPE and GPW columns depends on the following parameter checks:

Colum Check of Warning/Error

GPW: VlanPrio VLAN priority, no evaluation, if not transmitted Warning

GPE: VlanID VLAN priority, no evaluation, if not transmitted Error

GPE: Goose ID GOOSE ID Error

GPE: App ID Application ID Error

GPE: DataSet DataSet Error

GPE: Conf. Ref. Configuration Revision Error

GPE: MAC MAC Address of Sender Error

GPE: SCD is GOOSE in config. File Error
Table 13: Checked parameters of a GOOSE, w ith the configuration f ile loaded

The totals of the warnings and errors are indicated in the GPW and GPE columns. 
With regard to the GOOSE parameters, the GPS column shows the overall status in traffic light colors.

It is possible to deactivate individual check criteria in the "Settings | GOOSE Parameter Checks" menu.
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The evaluation of the LOG and SCD columns allows the following conclusions if the configuration file is loaded:

LOG SCD Possible causes

X Configuration file not complete
GOOSE with incorrect GOOSE ControlBlock Reference transmitted
Incorrect configuration file loaded or wrong subnet choosen

X Not all devices connected
One device defective
Incorrect configuration file loaded or wrong subnet choosen

X X The transmission and the configuration file match – everything OK
Table 14: Possible causes for different combinations of the LOG and SCD in the GOOSE Monitor

The GOOSE Monitor Menu

Save
Saves the current view of the GOOSE Monitor as a CSV file under any name. 

View
Allows the user to hide individual columns of the GOOSE Monitor.

Output
Allows the user to select whether he wants to show all GOOSE or only GOOSE with errors.

Reset counter 
Resets all counters for warnings and errors and also the current status.

5 Menus

The program GOOSE Inspector is operated via menus. To call up the online help for all main menus and dialogs,
press the “F1” key (i.e. select the menu and press F1).

The menus and input boxes can be selected via the mouse or the keyboard. The key selection is performed via
the "Alt" key and an "access key". The “access key” is the underlined letter in the menu text (e.g. “D” in the File
menu) or in the designation of the input box. With some operating systems, the access key is only shown in the
menu text after selecting the menu (by pressing the Alt key).

For frequently used commands (online, offline, view), you can use the related hotkeys, see Hotkey operation.
Hotkeys are single keys or key combinations for the direct execution of a command. For example, “Ctrl+D”
deletes the packets in the Log file.

Be aware that the Alt key activates the menu selection (a menu is highlighted). When the menu selection is
activated, the keyboard shortcuts are not effective. Pressing the Alt key again deactivates the menu selection
again.
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5.1 File Menu

Use the commands of the File menu in order to open, save and print files.

Command Description Hotkey

Log delete… Deletes all packets in the Log file and the GOOSE references of the
GOOSE monitoring. Resets all counters.

Ctrl + D

Open… Displays the "Open file" dialog field for opening scd, icd, lg6, er6,
el6, fast and ascd files.

Save as… Displays the "Save file" dialog field for saving a 1:1 copy of the
current file (e.g. Log.lg6). New packets are principally stored in the
Log.lg6, Log.er6 and Log.el6 file.

Save all as... Displays the "Save all files" dialog field for saving a 1:1 copy of all log
files (Log.lg6, Log.er6 and Log.el6). The corresponding file name is
applied to all file extensions.

Close config file (scd/icd)…Closes the open configuration file.

Export... Displays the "Export file" dialog field. For more detailed information,
refer to the next chapter.

Print... Displays the "Print file" dialog field. For more detailed information,
refer to the next chapter.

Open log file Opens the Log.lg6 file in the user-specific data directory

Open error log file Opens the Log.er6 file in the user-specific data directory.

Open event log file Opens the Log.el6 file in the user-specific data directory.

Quit Switches to Offline mode, saves all Log files and the current program
version and quits the program.

Table 15: Functions available in the File menu 

Export

This dialog field serves for the definition of parameters for exporting the currently open file into a text file (for file
format lg6, er6 or el6) or a file in the lg6 format (only for file format lg6). Be aware that the output filter and the
output format are effective in this context. This allows the user e.g. to save only one specific GOOSE in a
separate lg6 file. The export of a text file is performed with all information of the Detailed view. 

Packet output
Select whether the output shall be performed as a text file or an lg6 file.

Path and name of file
The complete path, the file name and the corresponding file extension (txt or lg6) must be specified under "Path
and file name". 
e.g. C:\data\test.txt or C:\data\log.lg6. To start the output, click the OK button.

Print

Be aware that the output filter and the output format are effective when printing. All information of the Detailed view
will be printed.
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5.2 Mode Menu

Use this menu in order to switch the program online/offline.

Command Description Hotkey

Online The program saves listened packets in the current Log file. F8

Offline The program does not save any packets. F8

Offline Analysis The program starts an Offline Analysis. See next section for more
details.

Table 16: Functions available in the Mode menu

Offline Analysis

The function Offline Analysis search's in the Log file for dynamically defined DataSets and reports.
The function Offline Analysis is finished with a program message.
The results are shown at the SCD Viewer and can be saved there within an ascd file.

Before an Offline Analysis a SCD file has to be loaded.
Make a record during a link connection or load a lg6 file with recorded data form a link connection.

Choose "Overwrite Log Files" at the start of the record.
Save the recorded data from the link connection as lg6 file before an Offline Analysis.

5.3 View Menu

In the View menu, you can select the packet type, the output format and the packet source. The selected
output format is also used for printing the Log file. Output filter allows the user to filter the packets.

Commands Description Hotkey

All packets Outputs all packets. 1

Only 61850 Outputs only GOOSE or MMS packets. The display behaves as if an
output filter was set to MMS and GOOSE.

2

Logical The output in the Detailed View is restricted to the most important
terms and contents.

3

Detailed The output in the Detailed View shows more detailed information. In
case of an erroneous transmission, Detailed provides additional
information concerning the structure of the packets.

4

Reserved The output of the Detailed View corresponds to the logical output. 5

Byte-ser. Hex. The output of all bytes of a packet is ‘hexadecimal’. The order
corresponds to the order received.

6

SCD The output in the Detailed View includes information from the loaded
configuration file.

File View Displays the packets of the lg6 file which has just been opened. The
user can scroll via the cursor keys or scroll bars, see Hotkey
operation.

F9

Online View The packets received are displayed in consecutive order. F9

GOOSE Monitor Opens the GOOSE Monitor.

GOOSE to Log All GOOSE references, the number of errors and the total number of
GOOSE are added in the lg6 file which has just been opened.

SCD Viewer Opens the  SCD Viewer which provides a comprehensive view of a
loaded configuration file.

Siemens Application
Monitor

Opens the Siemens Application Monitor (SAM).

Table 17: Functions available in the View  menu
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5.4 Settings Menu

Use the menu for the selection of the language, size and color of the output, network card, and for the selection of
the Log file settings.

Commands Description

Language Displays the sub-menu for the language selection.

Font size, packet colors…Displays the  Font size, packet colors dialog for setting the parameters for the font
size and the output colors.

Net interface/Log... This dialog serves for the selection of the network card to be used and for defining
the properties and the size of the circular buffer file. See also Parameters for network
and Log file.

GOOSE parameter
checks

Displays a window for the deactivation or activation of individual check criteria. The
settings are not saved at the end of the program. In order to ensure that a modified
setting becomes effective, the current log file must be reloaded.

Error log settings Displays a window for the activation/deactivation and for the selection of the circular
buffer size of the error log file. The minimum size is 30MB.

Event log settings Displays a window for the activation/deactivation and for the selection of the circular
buffer size of the event log file. The minimum size is 30MB.

SNTP settings Displays a window for SNTP activation and parameterization.

SNMP settings Displays a window for SNMP activation and parameterization.
Table 18: Functions available in the Settings menu

5.5 Filter Menu

Use the menu for filtering the packet output on screen and on the printer and for activating and deactivating the
output filter.

Commands Description Hotkey

Output filter… Displays the Output filter setting dialog for influencing the output of the
packets.

F12

Output filter ON/OFF Activates or deactivates the output filter if you have defined the output
filter. This function allows you to deactivate the filter function without
having to redefine the output filter settings.

F11

Input filter... Display the Input filter setting dialog for influencing the recording in
online Mode.

Table 19: Functions available in the Filter menu

5.6 Help Menu

Use the Help menu in order to call up the online help and show the program version.

Commands Description Hotkey

Help… Opens the online help. F1

About… Displays the program version.
Table 20: Functions available in the Help menu
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6 Filters

6.1 Output Filters

The output filter influences the output of packets on screen, via a printer and upon the file export.

The output filter does not influence the recording of packets.

Filtering during and after a recording session

The output filter filters:

1. During the recording: packets for the online view

This allows the user to monitor individual packets in the Main Window and the Detailed View in real time,
such as one single GOOSE, an Information Report or “only erroneous” packets as a quick error overview.

2. During the recording: packets already saved in the Log.lg6 circular buffer file
This allows the user e.g. to filter an already detected error of a GOOSE. In order to avoid the loss of data,
however, the recording should be stopped if important events have occurred. Also read the related
information in the Chapter Circular Buffer File.

3. After the recording: packets of the current lg6 file 

This allows the user to restrict the display of packets in the Main Window and the Detailed View to those
packets which are actually relevant. The filter is also effective for the printing and export of a text or lg6 file.

Define output filter settings

Press the F12 hotkey to open the window for defining the output filter settings.

To activate or deactivate the output filter, press the F11 hotkey. The settings of the output filter will be
maintained even if it is deactivated.

The filter is active if you have selected at least one criterion and not deactivated the output filter. For more
detailed information, refer to the "Filter Menu".

An active output filter is indicated by a related note in the status bar and the “Filtered” note in the title bar of the
packet output. 
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Figure 26: Window  for defining the output f ilter settings

All selected criteria are linked with a logical "and" operation, i.e. all conditions must be met for the packet to be
output.

Packets from
If this checkbox is ticked, only those packets which were received after the specified time are displayed.

Packets until
If this checkbox is ticked, only those packets which were received before the specified time are displayed.

Packet status
This parameter defines only error-free or erroneous packets. This filter is not effective if you have marked both
fields at the same time or no field at all.

Packet source
This parameter defines whether packets are output from the server and/or client.

Packet type
This parameter defines the packet types to be displayed.
- MMS according to 61850
- GOOSE according to 61850
- Detects GSE and SV and displays them in hexadecimal format.
- PackX stands for all remaining packets.
If you select only MMS and GOOSE, this corresponds to the selection of the “Only 61850” view.
This filter is not effective if you have marked all fields or no field at all.

IP address (MMS)
If you activate this parameter, only packets with this address will be displayed (source or target).

Text 1 or 2
Displays only those packets which include the text. Since the 61850 references are transmitted in plain text,
this option allows e.g. the output of only those packets which concern a logic device. To output only a specific
report, enter its Report ID.

GOOSE reference
All GOOSE ControlBlock references are saved when opening an lg6 file and listening. This option allows you to
restrict the output to one single GOOSE. For more detailed information, refer to the following Chapter "Special
Filter Functions for Quick GOOSE Analysis".
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Packet number
The packets in the Log file are numbered (1-n). This filter allows you to select a range or just one or two
individual packet numbers.

Field 1 Field 2 Field 3 Field 4 Output

equal 500 of any Packet 500

equal 500 or 600 Packet 500 and 600

equal 500 to 600 Packets 500 to 600

unequal 500 or 600 All packets except 500 and 600

unequal 500 to 600 All packets except 500 to 600
Table 21: Examples for f iltering according to packet number

Packet length
These boxes allow you to filter packets with a specific length. The input and processing logic is identical with
the packet number.

Save and Load buttons
These buttons allow you to save and load filter settings. The .flt file extension is used.

Reset button
Clicking this button deactivates all filter criteria. This button therefore allows the initiation of an individual filter
setting.

Special Filter Functions for Quick GOOSE Analysis

By clicking the right mouse button, special, context-related filter functions are available for the quick restriction
of GOOSE with a warning or error.

1. Select one GOOSE1 and then click with the right mouse button to activate "Filter (only erroneous)".
2. Switch to the Main Window and place the error message to be analyzed at the uppermost position.
3. Next, click with the right mouse button to activate “Filter (all)”.
4. Scroll up by one packet in order to view the packet received before the erroneous packet.

1The following options are available by clicking with the right mouse button in the GOOSE Monitor, in the
SAM (tree view or GOOSE Monitor window) or SCD Viewer:

Filter (all)  => Shows all GOOSE packets of the selected GOOSE ControlBlock reference.
Filter (only erroneous) => Shows only erroneous GOOSE packets of the selected GOOSE ControlBlock

reference.
 
Now by clicking the right mouse button  in the Main Window a selection window can be opened there. By
switching between "Filter (only erroneous)" and "Filter (all)", you can analyze all error messages of the
corresponding GOOSE ControlBlock reference. “Output filter ON/OFF” allows the temporary display of all
packets in order to detect the larger context of a fault.
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Figure 27: Context-related f iltering in the Main Window

 

Special Filter Functions for Reports

By clicking the right mouse button, special, context-related filter functions are available for the quick restriction
of reports.

1. Open the SCD Viewer and select within the Report tap or the DynRep tap a Report Control at the highest
level.
2. Next, click with the right mouse button to choose between "Filter by reference" or "Filter by report id".

This automatically sets the output filter criteria MMS, Text 1 and Text 2 and activates the output filter.
At the main window only MMS which match Text 1 and Text 2 will be displayed.
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6.2 Input Filters

The input filter defines which package types will be captured or not. Thus it is possible, to reduce the recording to
the needed package types only. This reduces the CPU load and the Log file contains more relevant data.

Not captured packages are not in the Log file, are not shown and are not available for a later analysis.

Define input filter settings

The settings of the input filter can only be changed in offline mode.

There are three different control modes:

not active               => All packages will be recorded. This is the default control mode.
temporary active => Only the chosen types of packages will be recorded. A restart of the program will

change the control mode to "not active".
permanent active      => Only the chosen types of packages will be recorded. A restart of the program will

restore the last settings and the control mode will be "permanent active" again.

Figure 28: Window  for defining the input f ilter settings

Package types are:

- MMS 
- GOOSE according to 61850
- GSE (filtering, but no decoding)
- SV (filtering, but no decoding)
- PackX stands for all remaining packets.

Viewing input filter

The status of the input filter and output filter is shown in the footer of the Main Window.

In case of a recording with aktive input filter, there will be a program message at the beginning and end of the Log
file.
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7 Defining Settings

7.1 Font size, Packet color

This dialog serves for the definition of the font size and the colors of the packet output. An example of the
selected colors is provided in the left-hand field.
The parameters are saved in the “W61850.cfg” file.

Font size
Select the desired font size.

Blank line between Messages in %
You can enter values between 0 and 200 percent. Zero means no blank line; 200 means two blank lines. The
value only refers to the Main Window.

Server
Select the text color and the background color for the server.

Client
Select the text color and the background color for the client.

GOOSE
Select the text color and the background color for the GOOSE.

Head lines
Select the text color and the background color for the head line. The Main Window is filled up by the background
color of the head line.

Error message
Select the text color and the background color for the error and program messages. 

7.2 Parameters for Network and Log file

In this dialog, you select the network card to be used and define the properties and size of the Log file.

Network card
Select the desired network card.

Max. size of Log file [MB]
100MB is the default setting. Define the size in million bytes. Observe the notes provided under Log file with
regard to the size and restrictions. The memory capacity indicated here must be available on the hard disk.The
minimum size is 30MB.

Data directory
In Online mode, the program always saves the new packets in the Log.lg6 circular buffer file stored in the
directory indicated here. The error log file log.er6 and the event log file log.el6 are stored in the same directory.
In Offline mode, you can save a copy of Log.lg6 under a different name in any directory (“File | Save Log as”
menu) or load an existing lg6 file for analysis purposes (“File | Open Log”).

7.3 SNTP function and parameters

In this dialog field, you activate and define the parameters for the SNTP client (SNTP = Simple Network Time
Protocol) which synchronizes the PC system clock.

This function may only be used if no NTP or SNTP service is yet active on the PC.
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The SNTP server is requested for the first time when clicking on OK to confirm the dialog. An error message is
displayed if a malfunction has occurred.

General functioning
At the beginning of the recording and every 10 minutes afterwards, the program requests the current time from a
configurable SNTP server. The time of day is always immediately transferred to the PC system time.

Time leaps of up to one second do not visibly effect the time stamp of the data packets. The adjustment is
performed seamlessly. Time leaps of more than one second are accepted immediately and documented with a
program message in the log file. If this occurs more than twice in succession, the recording is aborted (i.e. the
program goes offline) and a program message is written in the log file.

On/Off
Activates and deactivates the SNTP client.

Server 
Enter the IP address of the SNTP server.

Port
Enter the port of the SNTP server.

7.4 SNMP function and parameters

With this dialog field, you activate and define the parameters for the SNMP agent (Simple Network Management
Protocol) which supports the 2c protocol version.

When clicking on Apply or OK in the dialog, all changes are applied immediately, i.e. even if a recording is still
in progress. The history memories of already captured SNMP Masters are deleted (see also Multi Master). All
settings are saved at the end of the program.

General functioning
The SNMP agent responds to the following SNMP requests from an SNMP Master:

Get
Walk
Set (1.3.6.1.2.1.1.x only)

The W6GI.mib file is located in the installation directory. The file can be opened with a text editor and includes
plaintext information on the individual data items.

Special marker functions
Since it does not make sense to notify the occurrence of an individual, short-time fault as a permanent, static
warning or error, the two data fields behave as markers. They show the status since the last request.

enterprises.34655.10.2.marker.1 = warning 
indicates whether one or several new warnings have occurred since the last request. In this case, the value is
10. Otherwise, the value is 01. If the program is offline, the value is 11.

enterprises.34655.10.2.marker.2 = error 
indicates whether one or several new errors have occurred since the last request. In this case, the value is 10.
Otherwise, the value is 01. If the program is offline, the value is 11.

This means that the two double-point indications show whether any warnings or errors have occurred at all.
However, they do not indicate the frequency of occurrence.
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The SNMP Master is therefore responsible for recording, signaling and archiving this information in a suitable
manner.

On/Off
Activates and deactivates the SNMP agent.

IP address 
Enter the IP address or the name of the connection via which the SNMP agent shall wait for requests.

Port
The standard port for listening is 161. You can change the port in order to avoid conflicts with other agents (e.g.
the Windows SNMP agent).

Multi Master
For special marker functions, the program must record the history of each requesting SNMP Master. It must be
possible to distinguish all SNMP Masters based on the requesting IP address or the port.

If an SNMP Master sends a first request during a recording with warnings or errors or if its history memory has
been deleted, these warnings or errors are signaled independently of their age. 

Multi Master / Check IP
Activates the distinction of SNMP Masters based on the requesting IP address.

Multi Master / Check Port
Activates the distinction of SNMP Masters based on the ports used.

Multi Master / Delete all entries
Activates the automatic reset of the data history for an SNMP Master which did not issue a request over a
selectable period of time. This option should always be activated whenever SNMP Masters send requests which
cannot be clearly identified based on the IP address and/or the port address.

Multi Master / after (in minutes)
Indicates the time during which an SNMP Master must send a request in order to prevent its data history being
deleted. Only effective if the "Delete old entries" option has been activated. 

Multi Master / Monitor window
Depending on the parameterization, the IP address, the port number and the time of the last request by an
SNMP Master are displayed here.

Configuration example 1:
SNMP Master 1 on Computer A:
IP address: 192.168.0.2
Port: 161

SNMP Master 2 on Computer B:
IP address: 192.168.0.3
Port: Cannot be set to a fixed value

=> Check IP "active" and Check port "inactive". Since Computer B does not have a unique port, the port must
not be considered.

Configuration example 2:
SNMP Master 1 on Computer A:
IP address: 192.168.0.2
Port: 161
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SNMP Master 2 on Computer A:
IP address: 192.168.0.2
Port: 162

SNMP Master 3 on Computer B:
IP address: 192.168.0.3
Port: 162

=> Check IP "active" and Check port "active". The combination of the IP address and the port is unique and
cannot be changed.

Configuration example 3:
SNMP Master 1 on Computer A:
IP address: 192.168.0.2
Port: 161

SNMP Master 2 on Computer A:
IP address: 192.168.0.2
Port: Cannot be set to a fixed value

=> Check IP "active" and Check port "active". For SNMP Master 1 on Computer A, a unique assignment of the
data history is possible. This SNMP Master will receive correct values. SNMP Master 2 on Computer A cannot
be clearly identified because its port can always change. Upon each request with a new port, a new data history
is created. This leads to incorrect outputs with "enterprises.34655.10.2.marker.1 = warning" and
"enterprises.34655.10.2.marker.2 = error". In order to ensure that the large number of unused data histories do
not unnecessarily fill the memory, "Multi Master / delete old entries" should be activated. The time period must
be sufficiently long in order to ensure that the data history of SNMP Master 1 is not deleted inadvertently.
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8 Circular Buffer Files

8.1 Circular Buffer Files

Structure and Functions
The file ID is indicated at the top of the Log.lg6 circular buffer file. It is followed by the parameters and the log
data. The log data are organized in a circular buffer. When the buffer is full, the oldest packet is overwritten by the
most recent packet.

To prevent this, you can delete the old packets before a new recording (Ctrl+D), increase the maximum size of
the Log file (see Parameters for network and Log file ) or restrict the recording time.

Restriction 
Since the program allows the analysis and filtering of existing data also during a recording session, the size of
the Log file must be restricted. Based on practical experience, the Log file should not occupy more than half of
your RAM. Packets might get lost if the Log file is too large and the Log file is filtered during a recording. 

Saving the contents of the circular buffer file and preventing the loss of packets
In order to save the contents of the Log.lg6 file, you must use the “File | Save as...” menu. To do this, you can
use any file name for the backup copy. 

Deleting the contents of the Log.lg6 file before the next recording (Ctrl+D) allows you to benefit from the maximum
recording time without the risk of packet loss.

Error Log File and Event Log File
The Log.er6 (error log file) and Log.el6 (event log file) circular buffer files are stored in the same directory as the
Log.lg6 file. They are created during the recording process and can only be used upon completion of a record.
Since only specific information is recorded, the circular buffers are sufficiently dimensioned for long recording
periods and thus allow the long-term recording of specific information.

The Log.er6 file always stores in succession the last error-free and erroneous GOOSE message which belong
together. Additionally, the general counter contents are stored in this file.

The Log.el6 file includes the first GOOSE message of each GOOSE and afterwards only those GOOSE
messages which notify the user about a status change. In addition, the general counter readings are stored in the
file. These might show errors which cannot be traced back by means of the event log file. Errors are only
documented completely in the error log file.

Both files can be parameterized. For more detailed information, refer to the Chapter "Settings | Error Log Setting"
or "Settings | Event Log Setting". 

Package loss display and circular buffer overflow display 
A red icon is displayed in the Main Window in case of a PC capacity overload and a loss of packages during a
recording session, which is e.g. caused through the use of third-party programs or the evaluation of already
recorded data.

In addition, the illuminated icon for each circular buffer file (log.lg6, log.er6 and log.el6) switches to red when a
circular buffer overflow has occurred. When the log.er6 or log.el6 circular buffer files are deactivated, the
illuminated icons are displayed in gray. In case of an overflow, old data is overwritten by new data. For long-term
records, it cannot be avoided that the Log.lg6 log file overwrites old data with new data. This means that the file
only allows a retrospect for a short period, but all packets are included. The log.er6 error log file and the log.er6
event log file record a comparably long period (depending on the data volume), but only include specific
information.
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9 Program and Error Messages

9.1 Program Messages

Program messages provide you with information about the program version, the start and end of a recording
session and the "Reset counters" event. If a GOOSE has not arrived within the specified time and includes the
status "Missing", this will also be documented in a related program message.

9.2 Error Messages

Packets which cause warnings or errors have the same priority with regard to their representation in the Main
Window. They are marked with an error text and displayed with the color defined for erroneous packets. If a
GOOSE contains errors, a short code follows for each detected error as described in Table 13 in the Chapter
"GOOSE Monitor".

Particularly deep coding errors cannot be mapped in the Main Window. These errors are only shown in the
Detailed View if the corresponding packet is actually fully decoded and compared with the structure data of the
configuration file.

Due to the restricted computing power, it is not possible to fully decode all packets and check them with regard
to all possible aspects during a recording session.

10 IEC 61850 Coding

10.1 IEC 61850 Coding

Coding of Data Packets According to 61850

The coding according to 61850 is defined e.g. in the following standards:

Standard Description

IEC 61850-7-1 Principles and modules of communication

IEC 61850-7-3 Abstract common data classes and attribute definition

IEC 61850-7-4 Definition of logical nodes, data objects and their logical addressing

IEC 61850-8-1 Mapping for communication within the entire station
Table 22: Most important standards of the IEC 61850 for decoding

The following packet types are decoded: MMS with BER Coding in case of transmission with TCP/IP and
GOOSE with BER Coding.
GSE and SV are not decoded.

10.2 MMS with BER Coding

IEC 61850-8-1 describes the mapping, i.e. the conversion of services and data with MMS (ISO 9506 -
Manufacturing Message Specification).

MMS services and data are described in ASN1.

The connection serves for the transmission of data in ASN1 coding which have to be interpreted according to
the formal rules of MMS and mapped to 61850.
For more detailed information, refer to IEC 61850 Coding.
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10.3 GOOSE with BER Coding

For more detailed information, refer to IEC 61850 Coding.

A GOOSE is used for the spontaneous and simultaneous transmission of time-critical data to several receivers.
The GOOSE is transmitted with a multi-cast address directly to the Ethernet level. The assignment of a higher
priority ensures that GOOSE are transmitted faster by suitable network components than MMS packets.

In a GOOSE, the data is transmitted as MMS data types in ASN1 coding.

Figure 29: Structure of a GOOSE

11 Terms and Abbreviations

Definition of Terms

lg6 file
Files in the lg6 data format are referred to as lg6 files.

Circular buffer file = Log.lg6 = Log file
The Log.lg6 circular buffer file is a special lg6 file. It is also referred to as Log file and exists only once.
The Log.lg6 file is the only file in which data is saved during a recording.
All functions described for lg6 files can also be applied to the Log.lg6 file.

The Log file becomes the lg6 file
If the entire contents of the Log.lg6 file, or only individual packets depending on the filter definition, are saved, this
file is assigned a file name and the .lg6 file extension. This file then has to be referred to as an lg6 file and no
longer as a Log file. 
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Abbreviations

Abbreviations in the GOOSE Monitor, the SAM and the SCD Viewer are described in the corresponding chapters.

$ Hexadecimal format
AppID Application Identifier
ASN.1 Abstract Syntax Notation 1
CB Reference GOOSE Control Block Reference
Client The packet was sent by the client.
d= Delta time in seconds = time of the current packet – time of the previous packet
DA Data Attribute
DO Data Object
FCDA Functional Constaint Data Attribute
GOOSE Generic Object Oriented Substation Event
ICD IED Configuration Description
IED Intelligent Electronic Device
LD Logical Device
lg6 file see Definition of Terms
LN Logical Node
Log file see Definition of Terms
Log.lg6 see Definition of Terms
LSU Leap Seconds Unknown
MMS Manufacturing Messaging Specification
Packet X No 61850 packet
PM Program message
SAM Siemens Application Monitor
SCD System Configuration Description
Server The packet was sent by the server
SGM Single Goose Missing. SGM is a warning and not an error.
SNMP Simple Network Management Protokol
SNTP Simple Network Time Protokol
VLAN Virtual LAN

 
IP/TCP packets

ACK Acknowledgment number valid bit
Ack= Acknowledgment number
ARP Address Resolution Protocol
DF Don’t Fragment
Fin End of data flag
ID Identification
IP Internet Protocol, Internet Protocol address
MAC Media Access Control Address
MF More Fragments
Offset Fragment offset
Packet Packet, frame
Prot Protocol Version
PSH Push control bit
RST Reset connection flag
Seq= Sequence number
SYN Synchronize sequence numbers flag
TCP Transmission Control Protocol
TLg Total Length = Length IP Header + data
TOS Type of Service
TTL Time to Live
Type= Packet type (hexadecimal)
UDP User Datagram Protocol
URG Urgent pointer valid flag
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Window= Number of data bytes which the sender of this segment is willing to accept

12 Known Properties and Restrictions

Known properties and restrictions do not give rise for any claim for warranty for defects.

Known properties and restrictions do not give rise to any claim for correction of defects.

1. Warnings are output in the same color as errors in the Main Window
There is no specific color for warnings in the Main Window.

Read the output text which includes a hint regarding the cause of the message.

2. Graphical effects in the Main Window
Graphical effects occur if a window overlaps with the Main Window. On the other hand, the Main Window is
working very quickly and in a resource-saving manner.

If this effect proves disturbing, you can remove it by clicking on any other window and then back on the main
window. 

3. No formal check of configuration files
The configuration files (SCD or ICD) are not checked based on formal criteria during the read-in process.
For example the program does ignore missing GSE Control.
In Edition 2.0 missing GSE Control is allowed. In Edition 1.0 missing GSE Control was not allowed.
The program does not give any hint if GSE Control is missing. The import of SCD file will not be aborted. 

Check the configuration files by means of appropriate tools before reading them into the Program.

4. Deviations in the encoded data section of GOOSE or MMS are not detected in real time
Since not all packets are completely decoded in real time, discrepancies in the encoded data section remain
undetected during a recording. Discrepancies are only shown during the specific output of packets in the Detailed
View.

5. Effect of the size restriction of the Log.lg6 file

The program runs slowly in case of an excessively large Log file

The Log.lg6 file is structured as a circular buffer, and the size can be defined. If the file becomes too large and the
operating system relocates parts of the file to the hard disk, mainly the output of filtered data becomes very slow.
The filtering in the "File View" in the Main Window during a recording can lead to a packet loss in this case. This
function therefore should not be used with large Log files. For the same reasons, we recommend not to run any
further programs on the same computer during a recording.

Based on practical experience, the Log file should not be larger than half as large as the physical RAM. 2GB is
the absolute upper limit. In case of a large network with 1,000 different GOOSE of a small size with an average
transmission interval of 1.5 seconds, this corresponds to a recording period of approximately 4 hours. 

Principal “data loss” in a Log file due to the circular buffer function

Due to the organizational structure as a buffer memory, old packets and program messages are principally
overwritten by new packets as soon as the configurable size of the Log file has been reached. In this case, only
the most recent packets and program messages are stored in the Log file upon completion of the recording. 
The counters for notes and errors in the GOOSE Monitor, however, are incremented during the entire recording
period. The views and counter readings in the SAM or GOOSE Monitor, immediately on termination of the
recording, therefore cannot be reached through loading the Log file a second time. 

Delete the Log file before starting a new recording session and restrict the recording period in order to be able to
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precisely trace individual events.

Use the error log file and the event log file in order to trace back switching states and errors in case of long-term
records.

The number of a packet changes as soon as the circular buffer is full. 

When the circular buffer file is full and the recording persists, the numbering of the packets is changed
consecutively. The most recent packet always has the highest number, whereas the oldest packet of the circular
buffer file has the number 1. Since a new packet first has the highest number and then becomes older, it finally
has the number of the last packet (1) and is overwritten afterwards. The analysis (filtering) in a completely filled
circular buffer file, during a recording, therefore does not make sense.

6. Long loading times of lg6 files and configuration files
The loading of very large lg6 files and very large, complex configuration files can take several minutes depending
on the processing power of the computer. During this time, the program cannot be used for other functions.

When using notebooks and laptops, it must urgently be ensured that the CPU can run at full speed. The power
management of notebooks and laptops can significantly reduce the CPU performance, which can result in a
multiplication of the loading time.  

7. Not all MMS are detected and decoded
Not all MMS are decoded at the present time. Individual types are not implemented.

8. GSE (GSSE) and SV (SMV) are not detected and decoded

9. Dynamically created Information Reports are represented at the MMS level
Dynamically created reports are not described in the configuration file and therefore are only represented at the
MMS level.

Use the Offline Analysis of data, monitored during a link connection.
This makes it possible to show data references within dynamically defined reports in many cases.

10. The representations in the SAM are not and cannot be saved directly

As long as no overflow of the Log.er6 circular buffer file has occurred during the recording, the representation can

be fully restored by loading the Log.er6 error log file and the configuration file used at the time.

11. When starting the program, the Log.lg6 file, but not the last configuration file is loaded
automatically
Load the desired configuration file via the “File” menu.

12. The program always goes offline upon termination and always starts offline

13. Loss of packtes due to the use of other programs during a recording
The monitor program does process data in real time during a recording. If the PC is overloaded this may cause
the loss of packets and the recording is not complete.

The loss of packets is displayed by the monitor program.

We recommend not to run additional programs which cause heavy load during a recording with high network load.
We recommend to use the input filter to reduce the network load. Please record only packet types (i.g. GOOSE
and MMS) you really need.
This is of particular importance if you run the monitor program on a host or
substation host.

14. No support for some features of edition 2.0 
The program does not support all features of the edition 2.0. Mainly not supported are:
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- Datatype currency
- ReasonCode
- Validation of ConfRevision from GOOSE
- Parts of IEC 8802-3 frame format
- IEC 8802-3 frame format with HSR link redundancy
- IEC 8802-3 frame format with PRP1 link redundancy
- GOOSE type 1a 88-B8 APPID 10
- Reserved first part of on Ethernet
- srcXX attributes and serviceType within Input/ExtRef

15. SAM does not support FCD 
GOOSE with FCD (in place of FCDA) and inputs for FCD (in place of FCDA) will not be matched and displayed
fully in SAM.

Please use the SCD Viewer to get the mapping of GOOSE to input in detail.

16. Desc of SDI will not be used
The desc of SDI will not be used. Instead of this the corresponding name parts of the reference will be used within
source and target description in SAM.

17. Offline Analysis does not always lead to complete and correct results
The Offline Analysis does base on interpretation of data which have been monitored during a  link connection.
It does not apply to all thinkable and allowed approaches for dynamic definitions of reports and DataSets.    

18. FC (functional constraint) is no longer shown for every single attribute in the Detailed View
The Detailed View is now more clearly but in case of FCD with FC = XX the FC of single attributes is not
displayed.

Use the SCD Viewer to get information about the FC of attributes.
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13 End User License Agreement

Copyright (C) 2017 Berthold Boeser Engineering Consultants
End User License Agreement

By using this program, you accept this License Agreement and confirm that you have read and understood its
contents and agree with of its all terms and conditions. 

1) I herewith grant the purchaser of my program a non-exclusive right of use. The program may only be used with
the dongle purchased. The program may be installed on several computers, and a backup copy may be
performed. Any alterations to or transfer of the program are prohibited. It is not allowed to use the license (dongle)
simultaneous with several users (e.g. within a server operating system) at the same time.

2) The program and the documentation were created with the utmost care. Any errors which prevent the use of
the program for the intended purpose shall be rectified within a period of 12 months.

3) Known properties and restrictions do not give rise for any claim for warranty for defects and do not give rise to
any claim for correction of defects.

4) The purchaser uses the program at his own risk. Except cases of gross negligence or deliberate actions, I do
not assume any liability for:
- losses or loss of profit through the use of the program
- loss or damage of data
- consequential loss or business interruption
- personal injury of any kind

5) Any claims for damages, independent of their legal basis, are restricted to the level of the license fee paid. Any
liability for claims shall cease 12 months after delivery.

6) This Agreement shall be subject to German law. Place of jurisdiction for disputes which arise from or in
connection with this Agreement shall be my main place of business. If individual provisions of this License
Agreement are or become invalid, this shall not affect the validity of the remainder. Invalid provisions shall be

replaced by such provisions which are valid and come closest to the intended purpose of the original.
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